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INTRODUCTION

IMPORTANT: PLEASE READ FIRST

After some thought, I decided not to write the usual long introduction
for this workbook. Most people seem to skim read the introduction or
ignore it completely. I then receive lots of emails querying important
points from the introduction that were missed. To ensure this doesn’t
happen to you, please read the following .

This workbook teaches you Luminosity Masking using Adobe
Photoshop. In it, you will learn many di ffferent methods for creating
masks and Selections based on the Luminance, Colour and Saturation
information in an image. It also explains how to use the masks you
create to improve any image. My only assumption is that you are editing
photography .

A common misunderstanding by those new to Luminosity Masking is
that producing the masks not important. This is not true. There are many
techniques to choose between, and which is best depends on what you
are trying to achieve. This book therefore devotes a lot of space to
explaining these di ffferent techniques and you will fĳind yourself creating
many masks in the early chapters. This is a very important step in
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INTRODUCTION

learning about Luminosity Masks and I would urge you not to rely on
third party tools to create these for you, at least not initially. Then, once
you reach the chapters on how to apply Luminosity Masks to editing
situations, you will fĳind the work much easier .

As you progress through the book, you may fĳind there is some repetition.
For example, I may repeat the shortcut keys regularly for some tasks.
This is because the chapters cover many di ffferent techniques and
including such details allows the chapters to stand alone as a reference in
future .

The examples that I’ve shared in the workbook use landscape
photographs because I am a landscape photographer. This doesn’t
prevent you from using the same tools and techniques with any style of
photography. Portrait photographers will fĳind working with Luminosity
Masks especially bene fĳicial .

Whilst this workbook was written and based on the latest version of
Adobe Photoshop CC, it can be used with earlier versions. You can even
use these methods in versions of Photoshop from 10 years or more ago –
they are timeless. But what you can’t do is use them with other software
like Photoshop Elements or A fffĳinity Photo. Those require di ffferent
techniques that work in di ffferent ways .

I suspect that some of you reading this book already have Photoshop
Extension panels for Luminosity Masking. Three such panels which are
mentioned later in this book are Raya Pro, Lumenzia, and TK Actions.
Whilst these panels are mentioned, you do not need to use them, and no
instruction on their use is given. But by learning the techniques set out
in this book, you will fĳind that if you later decide to invest in one of these
panels, you will fĳind them much easier to use .

In terms of your existing Photoshop skills, I have assumed that you can
fĳind your way around the Photoshop interface. That you know how to
add and work with layers to edit an image. And that you feel reasonably
comfortable working with masks. Whilst I do explain everything that you
will need to know, if you don’t have some experience of the things
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INTRODUCTION

mentioned, you will fĳind this book di fffĳicult to understand. Luminosity
Masking is not for Photoshop beginners .

The fĳinal important point about this book is that it’s designed as a series
of exercises. You should therefore read the book in the order presented,
and please don’t skip anything – even if you think that you already know
it. The exercises are presented as chapters which you can read. But you
will gain the most value from following the exercises using the example
images. You can download the images accompanying the book from my
website at https:// lenscraft. co. uk/ learn- photo- editing- books/ useful-
downloads- books/ .

Whilst you’re doing this, please take a moment to join my monthly
newsletter. This is where I publish new information about books and
courses as well as tutorials. I think you will fĳind it quite di ffferent to a lot
of other photography newsletters .

AMERICAN/ENGLISH SPELLINGS

Many of the terms used in this book have American spellings which may
di fffer from the English spelling. As I was born and live in the UK, I use
the English spelling in the book, UNLESS it relates to a feature of the
software with an American spelling. For example, I may talk about
making a Color Range Selection. This is a feature of Photoshop and so
uses the American spelling. But when I’m referring to say the colour of
an object or the colour red, I will use the English spelling of colour .

I do encourage you to contact me with any errors you fĳind, but please be
sure the word is genuinely misspelled and not using the
American/English variation for a reason. If you do fĳind any genuine
mistakes (and there will be some in a book of this length) please email
me using robin@ lenscraft. co.uk .
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INTRODUCTION

NOTE FOR WINDOWS USERS

This book was developed using an Apple Mac computer and the Mac
version of Adobe Photoshop CC. If you are a Windows PC user, you may
notice some minor di ffferences between the screenshots and your
computer. The good news is that Photoshop is largely standardised
across both operating systems. You should therefore have little di fffĳiculty
following the book whether you use an Apple Mac or a Windows PC .

TRADEMARKS

Throughout this book, I may have referred to various organisations and
their products. Where reference is made to any trademarks or product
names it is purely in an editorial capacity. There is no intention of
copyright infringement, and all trademarks are recognised and respected .

DISCLAIMER

Whilst I have made every e fffort to ensure the information in this book is
accurate and factual, it does represent my views and approach to photo
editing. Some may disagree with the information I present but I have not
intentionally made any omissions or errors. If you do fĳind something you
believe needs correcting, please contact me by email using
robin@ lenscraft.co.uk .

Thank you and I hope that you enjoy this book .
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ONE
UNDERSTANDING LUMINOSITY

MASKS

Have you started reading here? Then please return to the start of
the book because you’ve missed some important information .

This chapter will provide you with an introduction to Luminosity Masks
and how to read them. It’s essential that you understand how to read
masks. This will help you to use the di ffferent Luminosity Masking
techniques e fffectively. Being able to understand the mask by looking at
it, allows you to make important decisions when editing, like choosing
the best mask to use .

We will also look at the Layers Window in Photoshop to ensure you
understand some of its features and tools. Whilst I have assumed you
know the basics of editing with Photoshop, you may not yet know some
of the important points when working with layers .

The fĳinal part of the chapter then demonstrates how Luminosity Masks
can improve simple adjustment techniques like Dodging and Burning .
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UNDERSTANDING LUMINOSITY MASKS

UNDERSTANDING THE ROLE OF MASKS

When we add an Adjustment Layer to edit an image in Photoshop, the
adjustment is applied to the entire image. This is known as a global
adjustment. But there are times when we don’t want our adjustment to
afffect all areas of the image. In these cases, we want to apply our
adjustment to speci fĳic areas which is known as making a local
adjustment. The way we create local adjustments in Photoshop is by
using a mask to restrict where the adjustment is applied. Let’s look at an
example of a simple mask and the e fffect it has on an image .

In the following screenshot, you can see an image that’s been edited in
Photoshop. Half the image is seen in colour and the other half is in black
and white .

Applying a Black & White Adjustment Layer to an image using a mask.

This e fffect was created using a Black & White Adjustment Layer, which
converts a colour image to black and white. The reason half of the image
is black and white, and the other half is in colour is that a Layer Mask
was used to restrict the e fffect. You can see this Layer Mask in the
following screenshot .
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UNDERSTANDING LUMINOSITY MASKS

The Layers Mask attached to the Black & White Adjustment Layer.

The Layer Mask is the same shape and dimensions as the image it’s
applied to. Half of the Layer Mask is black, and the other half is white. If
you compare this to the image, you’ll see that the image is in colour
where the Layer Mask is black. Where the Layer Mask is white, the
image is converted to black and white. This is important to remember as
it’s the basis for how masks work .

The mask is the same size as the image that it’s applied to and is often
attached to an Adjustment Layer. That’s when we might also call it a
Layer Mask. From this point on in the book, we will use the term mask
rather than Layer Mask .

By default, when we add an Adjustment Layer (like the one converting it
to black and white), a white mask is attached to that layer. Because the
mask is white, it allows the e fffect of the Adjustment Layer to be seen
across the entire image. It’s only if we paint with black on the mask that
we hide the e fffect of the layer where we paint with black. This is why the
Black & White conversion is hidden from half of the image because only
half of the mask is white .
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UNDERSTANDING LUMINOSITY MASKS

Now let’s look at an example where we apply a black to white gradient to
the mask .

Applying a black to white gradient on the mask attached to the Black &
White Adjustment Layer.

Notice in this example, that the transition between colour and black &
white is now graduated so that you don’t see a hard cut-o fff. This was
achieved by painting a black to white gradient on the mask attached to
the Black & White Adjustment Layer. You can see this mask in the
screenshot below .
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UNDERSTANDING LUMINOSITY MASKS

The graduated black to white mask.

What’s important to notice in this example, is that the image changes
from colour to black & white gradually. If you look at the transition area
on the mask, between the black and white areas, we see grey. This allows
the Black & White Adjustment Layer e fffect to be partially seen. The
lighter the grey, the more we see the layer’s e fffect. Whilst the darker the
grey, the more the layer’s e fffect is hidden by the mask. This is what
blends the Black & White Adjustment Layer e fffect so that we don’t see a
clear point of transition from colour to monochrome .

One of the bene fĳits of using Luminosity Masks is that they create a
natural transition which helps to blend your adjustments into the image.
The key to understanding the rest of this book is learning how to read a
mask. At its most basic, where you see black, the mask is hiding that part
of the layer that it’s attached to. But where you see white, the e fffect of
the layer is seen in the image. Then where you see grey, you will partially
see the e fffect of the layer. The darker the grey the less the layer’s e fffect is
visible, whilst the light of the grey the more it’s seen .

Now let’s look more closely at layers and the Layers Window in
Photoshop .
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UNDERSTANDING LUMINOSITY MASKS

WHAT YOU NEED TO KNOW ABOUT LAYERS

When editing an image in Photoshop, there are a few ways you can apply
an adjustment. These are :

1. In the “Image” menu, under the “Adjustment” submenu. Here
you will fĳind a list of adjustments like Levels, Curves, and
Vibrance. Applying one of these to an image will change the
pixels of that image and is a destructive edit. We call it a
destructive edit because it’s not possible to change the settings
you applied later if you want to remove or reduce them .

2. By applying an Adjustment Layer to the image. The Adjustment
Layers provide the same adjustments as found in the
Adjustment submenu mentioned above. The di ffference is that
each of these adjustments creates a new Layer in the Layers
Window. When you apply adjustments in this way, they are non-
destructive, as you can turn them o fff and on, as well as change
the settings in the future .

3. By applying a Filter to the image. These changes are also
typically destructive and can’t be adjusted or removed in the
future .

Here’s a screenshot of the Photoshop Layers Window, showing the
example image from the start of this chapter .
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UNDERSTANDING LUMINOSITY MASKS

An example of the Layers Window in Photoshop.

In this screenshot, we can see the image has three layers. At the bottom,
we have the background layer containing the image, which is comprised
of pixels. Then above this, we have two Black & White Adjustment
Layers called “Black & White 1” and “Black & White 2”. Both layers have
a Layer Mask attached to them which is shown as a black & white
thumbnail. You can see these indicated by the red box. If you look at
these thumbnails, you’ll see that they match the masks that we’ve looked
at previously .
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UNDERSTANDING LUMINOSITY MASKS

The order of the Layers in the Layers Window is important. This is
because pixel layers like the background layer will hide any layer they
cover. In contrast, the Black & White Layers are examples of Adjustment
Layers. These apply an e fffect to the image but never hide the layers
below them. Because of this, we can stack layers on top of each other
and you will see their combined e fffect on the image .

Now let’s look at an example of a Luminosity Mask .

WHAT IS A LUMINOSITY MASK

Luminosity Masks may sound complicated, but they aren’t. In fact, they
are just like any other mask. The only reason we call them Luminosity
Masks is because they are created using the luminance information in
the photo being edited. By luminance information, we just mean how
light or dark each of the pixels in the image is .

Here’s an example of a Luminosity Mask created from the photo that
we’ve been using .

Example Luminosity Mask.
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UNDERSTANDING LUMINOSITY MASKS

If you’re thinking that this looks like the image converted to black and
white, then you’re right. Just like the other masks we have been looking
at, a Luminosity Mask is a black and white image. Where you see white,
the mask allows the layer to be seen. Where you see black, it hides the
layer. And of course, grey allows the layer to be partially visible,
depending on how light or dark the grey is .

Although we have been talking about Luminosity Masks being created
from the luminance information of an image, we can also create them
from other sources. The colour channels in an image are another source
for creating these masks. Additionally, we can create Luminosity Masks
using the level of saturation in an image. We will be covering these
subjects and others later in the book .

Ultimately, Luminosity Masks work just like any other type of mask. But
if there’s nothing special about them, why are they so useful for photo
editing ?

WHY ARE LUMINOSITY MASKS SO USEFUL?

The main reason that we use a Luminosity Mask is that it allows us to
target adjustments in a natural way. This makes them perfect for editing
landscapes and many other types of photography. When you make an
adjustment using a Luminosity Mask, it allows the adjustment to blend
naturally into the image .

Carefully compare these two images .

Image before and after editing with Luminosity Masks.
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UNDERSTANDING LUMINOSITY MASKS

Here you see two versions of the same image. The image on the left is the
original RAW fĳile before editing. The image on the right was produced by
adjusting the image colour as well as Dodging and Burning. These
changes were made using Luminosity Masks to target them on speci fĳic
areas. The Luminosity Mask also ensured that there was a natural
blending of the adjustments, making them di fffĳicult to spot. These
changes were minor, but their combined e fffect on the fĳinished image is
signi fĳicant .

I’m sure you’re now keen to create your fĳirst Luminosity Masks and start
editing. But before we do, it’s extremely important that you set up
Photoshop correctly for masking. That’s the subject of the next chapter .
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TWO
SETTING UP PHOTOSHOP FOR

MASKING

The objective of this chapter is to set up Photoshop in a way that makes
working with masks much easier. To do this, we will create a new
Workspace in Photoshop which we can use when working with
Luminosity Masks .

Before we go any further, here’s what my default Photoshop CC
Workspace looks like .

The default Photoshop CC Essentials Workspace.
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SETTING UP PHOTOSHOP FOR MASKING

The Workspace in Photoshop is just the name for a collection of
Windows and how they are laid out on the screen. In the screenshot
above, you can see the Windows grouped on the right side of the screen.
This is the default layout or Workspace. You may fĳind that your layout or
Workspace is di ffferent from this, depending on the changes you’ve made
to it in the past. Sometimes you can make changes without even
realising .

Before we go any further, we should save your current Workspace in case
you want to return to it later. We can do this in the “Window” menu
under the “Workspace” submenu. If you click on the Window menu in
Photoshop and then hover over the Workspace submenu, you will see
several Options you can choose. In this list you will fĳind one called “New
Workspace…”. You can see this in the left screenshot below .

Saving the current Photoshop layout as a new Workspace.

After selecting the New Workspace option, you will see a dialog
displayed where you can enter the name of the Workspace. You can see
this in the above screenshot on the right. In this example, I’ve named the
Workspace to be “Temp”, but you can use a more meaningful name. You
can also see that there are three options in the dialog which are
“Keyboard Shortcuts”, “Menus”, and “Toolbars”. These have been
selected and will be saved as part of the Workspace as they can be
modi fĳied .

When you’re happy that you have saved your current layout as a new
Workspace, go back into the Workspace submenu. You should now select
the “Essentials (Default)” Workspace in the list. Once selected we will
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SETTING UP PHOTOSHOP FOR MASKING

reset it to the default. We are doing this in case you made changes to
your Workspace in the past. You will fĳind the option to reset the
Essentials Workspace in the Workspace submenu .

Here’s what my Essentials Workspace looks like once it’s been reset .

The Photoshop Essentials Workspace when reset.

As you can see, this is di ffferent to the Essentials Workspace I started
with .

Now that we have a common starting point, let’s make some changes to
con fĳigure the Windows for masking. If you click the Photoshop Window
menu, you will see a list of all the available Windows we can display.
Some of these will have a tick mark to the left of the name. These are the
Windows that are already visible in the Workspace. Currently, not all the
Windows that we want to use are visible, and in addition, some Windows
that we won’t use are shown .

Let’s start by selecting the Navigator and Histogram Windows in the list
to make them visible. When you do this, the Windows will be displayed
but they may be docked to a sidebar rather than in the main area. You
can see an example of this below .
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SETTING UP PHOTOSHOP FOR MASKING

Navigator and Histogram Windows docked to the sidebar.

If this happens, you can click and drag the Windows, docking them with
the other Windows on the right of the interface. At the same time, let’s
remove some of the unwanted Windows from the area by clicking and
dragging them. In the following screenshot, you can see the Windows
have been dragged out of position, and they are now fl oating over the
image area .
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SETTING UP PHOTOSHOP FOR MASKING

Floating Windows that have been removed from the dock area.

Having removed the Windows, you will fĳind that each one has a small
cross icon to the top left. Click this to close it. You should now have only
the Navigator and Histogram Windows visible at the top right of the
interface .

Something else that you may fĳind is that you need to resize the Windows.
Often Windows like the Navigator will be too small, so you need to click
and drag on the bottom of them to make them larger. The Histogram
Window is also shown in a “Compact” view by default, as seen in the
screenshot below. This is unlikely to be of much use to us and so we need
to change its settings .
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SETTING UP PHOTOSHOP FOR MASKING

The Compact and Expanded view the Histogram.

To switch the Histogram Window from the Compact to Expanded view,
click the icon showing four horizontal lines in the top right of the
Window. This displays a menu where you can select the Expanded view.
You should also select the options to “Show Statistics” and “Show
Channels in Color” from the menu. Once you’ve done this, your view of
the Histogram Window should look like the screenshot on the right
above .

Now look at the Windows docked on the right of the screen. These are
arranged into three groups, one at the top, one in the middle, and one at
the bottom. In the top group, you should now have the Navigator and
Histogram Windows. Then in the middle group, you should see the
Properties, Adjustments, and Libraries Windows. The only one of these
that we don’t need is the Libraries. You should therefore click and drag
the Libraries Window to remove it from the group. After that, you can
close it by clicking the X icon in the top left of the Window. This will
leave only the Properties and Adjustments Windows in the central group .

In the bottom group, you should see the Layers, Channels, and Paths
Windows. Of these, we don’t require the Paths Window, so you can
remove it from the group and then close it. This should leave the Layers
and Channels Windows in the bottom group .

When we are working with Luminosity Masks, it can be advantageous to
be able to view the Channels and Layers Windows at the same time. We
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will therefore click and drag the Channels Window to dock it in the
middle group. Your layout should then look like the Workspace shown
below .

New Workspace layout showing the Photoshop Windows arranged into
three groups.

When you have arranged your Windows like this, you can save the
Workspace. To do this, click the Photoshop “Window” menu and then
the “New Workspace…” option in the “Workspace” submenu. When the
New Workspace dialog is displayed, enter the name “Luminosity
Masking”. Also ensure the Keyboard Shortcuts, Menus, and Toolbar
options are selected so that they are saved. You can then click the Save
button to create the new Workspace .

Having saved the new Workspace, click the Photoshop Window menu
and hover your mouse over the Workspace submenu. You should now
see your new Luminosity Masking Workspace saved in the top section.
This will also have a tick mark to the left to show that it is the active
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SETTING UP PHOTOSHOP FOR MASKING

Workspace. If you ever fĳind that you change the Workspace in error, you
can return to the Workspace submenu and select the “Reset Luminosity
Masking” option there. This will reset the Workspace to the saved
position .

We now have a well con fĳigured Workspace for Luminosity Masking .
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THREE
YOUR FIRST LUMINOSITY

MASK

In this chapter, you will learn how to create your fĳirst Luminosity Mask.
In addition, you will look at how to switch between Luminosity Masks,
Selections and Channels. These are critical skills when creating and
using Luminosity Mask to edit photography .

This chapter will also examine a couple of simple ways you could use
Luminosity Masks to selectively edit a photograph. You will fĳind the
image used in this chapter available in the download fĳiles that
accompany this book. You can download these from my website using
the link .

https:// lenscraft. co. uk/ learn- photo- editing- books/ useful- downloads-
books/

This page contains links to download images for any of my published
books. Whilst you’re there, don’t forget to sign up for my monthly
newsletter if you haven’t already .

Below, you can see the example image used in this and several other
chapters of the book .
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YOUR FIRST LUMINOSITY MASK

Example image, together with a screenshot showing the Photoshop
Channels Window.

If you open the example image in Photoshop and check the Channels
Window, you will see that it is an RGB image. This means three colour
channels make up the image which are Red, Green, and Blue. You can
click on any of these channels in the Channels Window to view them.
They will then be displayed as black and white images. We will be
returning to look at these and how we can use them in a later chapter.
For now, you need to ensure that the RGB image channel at the top of
the Channels Window is selected. When you click on this, it ensures you
see a colour rather than a black and white image .

A common mistake when working with Luminosity Masks is to forget to
click the RGB channel as you are working. When this happens, you will
see a red overlay appear on the image. If this happens (or should I say
when), go to the Channels Window and click the RGB channel .

We will now load the brightness or luminosity information for this image
as a Selection. There are two methods we can use to do this :
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YOUR FIRST LUMINOSITY MASK

1. Using the Keyboard Shortcut of Cmd + Click on a Mac or Ctrl +
Click on a Windows PC. To do this, hold down the Cmd key or
Ctrl key on your keyboard. Now position your Mouse Pointer
over the RGB channel in the Channels Window. You will then
see a small icon appear below the pointer showing a square with
a dotted line around it. The icon is indicating that a Selection
will be loaded from the channel when you click. Click once with
your mouse to load the Selection .

2. Using the “Load Channel as Selection” icon at the bottom of the
Channels Window. The icon shows a circle with a dotted outline
and is indicated by a red arrow in the screenshot above. Be sure
you have the RGB channel selected in the Channels Window
and then click the icon at the bottom of the Window to load it .

When you use either of these methods, it loads the brightness
information from the colour image as a Selection. You will then have
what we call an Active Selection. To show there’s an Active Selection,
Photoshop displays Marching Ants on the image. This is an animated
dotted line around the selected areas. There are times when you might
not see the Marching Ants, but we will talk about those later. For now,
you should try both methods to ensure you can use either .

After loading a channel as a Selection, you can clear the Active Selection
by clicking the “Select” menu at the top of the Photoshop interface. You
can then choose the “Deselect” Option. You can also use the Keyboard
Shortcut Cmd + D on a Mac or Ctrl + D on a Windows PC. If you clear
the Active Selection by mistake, you can reselect it by using the
“Reselect” option in the “Select” menu .

Now let’s repeat the example and load the RGB channel again. You can
do this using either of the described methods. Once you have an Active
Selection let’s save it in case we want to use it in the future. Saving the
selection avoids the need to recreate it, which in some instances may be
time consuming or di fffĳicult .
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YOUR FIRST LUMINOSITY MASK

To save the Active Selection, click the “Select” menu at the top of the
Photoshop interface. Then click the “Save Selection…” option to open
the “Save Selection” dialog. You can see this in the following screenshot .

Saving an Active Selection as a new channel in the image.

In the screenshot, you can see the Marching Ants indicating there is an
Active Selection. Then in the “Save Selection” dialog, you can see several
options in the Destination section at the top. We can use these to choose
where we will save this Selection. In this example, the settings are to save
the Selection in the current document (the image is the document) as a
new channel. This is also where you enter the name of the new channel
that you want to create .

If you look below the Destination section, you can see the “Operation”
section is set to create a new channel. There are several other options
here, but they are currently greyed out and not available. Don’t worry
about any of the other settings for now. All we need to do is enter the
name “Lights 1” in the Name box. When you’ve done that, click the OK
button. You should then see a new “Lights 1” channel appear in the
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END OF SAMPLE
To obtain the complete book please visit:

https://lenscraft.co.uk/learn-photo-editing-books/


